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Introduction 
Microsoft Excel is a well respected industry standard accounting and statistical software. 

History 
Microsoft originally marketed a spreadsheet program called Multiplan in 1982, which became very 

popular on CP/M systems, but on MS-DOS systems it lost popularity to Lotus 1-2-3. Microsoft 

released the first version of Excel for the Mac in 1985, and the first Windows version (numbered 

2.05 to line up with the Mac and bundled with a run-time Windows environment) in November 

1987. Lotus was slow to bring 1-2-3 to Windows and by 1988 Excel had started to outsell 1-2-3 and 

helped Microsoft achieve the position of leading PC software developer. This accomplishment, 

dethroning the king of the software world, solidified Microsoft as a valid competitor and showed its 

future of developing GUI software. Microsoft pushed its advantage with regular new releases, every 

two years or so. The current version for the Windows platform is Excel 12, also called Microsoft 

Office Excel 2007. The current version for the Mac OS X platform is Microsoft Excel 2008. 

The above text was sourced directly from Wikipedia. To read more about the history of Microsoft 

Excel follow this link. http://en.wikipedia.org/wiki/Microsoft_Excel  

The environment and interface 
 

 

The Office Button 

The Name Box 

Ribbon 

Formula Bar 

Sheet tabs 

Different views 

Rows numbers 

Column letters 

http://en.wikipedia.org/wiki/Microsoft_Excel
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The Office Button: 

The Office Button is where you find document specific functions including Save, Save As, Print, New, 

Open etc. Also contained in this menu at the bottom is the Excel Options button. Will will go over 

this at a later stage. 

The Ribbon: 

The new Microsoft Office Ribbon is a new element from Office 2003 to Office 2007. Its aim is to 

replace the menus with similar functions all contained on a single tab. Each tab is grouped into 

similar sub-functions. 

The Name Box: 

The name box is the area where you can define range names, or look up cell references. This can 

become very useful when creating Vlookups. 

The Formula Bar: 

Is where a cell’s contents data is stored. You can also modify and edit a cell’s content or a formula 

contained in the formula bar. 

Column Letters: 

Columns are vertical and identified in alphabetical order. Once they reach Z, they then start on AA, 

then AB etc. The limit of columns is all the way out to XFD! For your information, that is 16384 

individual columns – and if you are using this many, chances are you really should be using a 

different application! 

Row Numbers: 

Rows are similar to columns, but identified numerically, from row 1 all the way through to row 

1,048,576. Rarely will you need to use all these rows.  

Sheet Tabs: 

A workbook by default will have 3 worksheets. You can manipulate these sheets by right mouse 

clicking on them and selecting the desired option. 

Different Views: 

The ‘Normal View’ is the default view. This is the usual view used when working in Excel. The middle 

view is ‘Page Layout’ view – where it actualy shows any headers and footers if applied and also page 

breaks. The right view, ‘Page Break’ view shows where pages start and finish. In this view you can 

modify margins etc. 
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Data Types 
 

Microsoft Excel automatically modifies the data type to what is predicts its intended purpose is. For 

example, if you typed 11/10/09 into a cell, it would automatically become a date formatted cell. 

The problem with this is that even if you select the cell and delete its contents, the formatting 

remains.  Give it a go. 

Step 1  Step 2  Step 3  Result 

 

 

Why did Excel put 1/01/1900 into the cell? 

The reason you got this result is because Excel remembered the cell formatting from step 1. 

You may be wondering why then did Excel return 1/01/09. Well the answer to this riddle lies is the 

way Excel works with dates and times internally. 

Excel stores all dates and times in a numeric value of how many days since the 1st of January 1900. 

This is why you got 1/01/1900 for 1. Therefore, if you were to type in 365, you will get: 30/12/1900. 

Clearing a cell’s format 

There will be times where you want to clear a cell’s format. There are a couple of options for this 

and most commonly you can either clear the cell’s format, leaving the original raw data, or you can 

clear the format and data, leaving a blank cell. 

 

Delete Type 1 and 

then hit Enter 

Home tab 

Clear button 
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Other formats 

Type out the following information; 

 
 

 This is a text string. Text automatically aligns left. 

 Although this data contains numbers, it is still referenced as a text string. 

As previously mentioned, dates can be formatted in various ways.  

Valid formats:  10/2/2002 

   10/2/02 

   10/2/2 

   10-2-02 

   10 Feb 02 

Non-valid formats:  10.2.2002 

   10\2\02 

Note:  Depending on how Excel has been installed on your PC, dates must be in the 

Australian format, for example DD/MM/YYYY and NOT the American format of 

MM/DD/YYYY. 

This is actually a manual Excel equation. 

Other data types 

Currency 

You can specify specific data types by having the cell 

selected and then selecting the appropriate option from the 

Number under the Home tab of the ribbon. 

The $ icon will convert selected cells into currency. This will 

automatically place a dollar sign in the cell and also make the 

data accurate to 2 decimal places. This data type will 

automatically round the displayed amount to a nearest 

1 

2 

3 

4 

Currency

 

Percentage

 

Comma style 
Decimal places 

Your name 

Your address 

Your date of birth 

The equals sign, then 10+40 then hit 

the enter key. 

1 

2 

3 

4 
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whole cent. However, no accuracy will be lost when rounding, as any calculations using this data will 

still be using the un-rounded value. 

Percentage 

This data type will automatically convert data into a percentage value. Therefore if you had the value 

0.45 existing in the cell, then clicked the % icon, it would then display as 45%. 

Comma Style 

This style will place commas in a numeric value data which usually makes it easier to read. 

Decimal Places 

By selecting this option you can either increase or decrease the displayed decimal places. If you 

decrease the number of displayed decimal places, the visible data will automatically round to the 

nearest whole decimal place, but the value will not loose accuracy. Like the currency type, all 

subsequent calculations made from the rounded cell will still calculate with the un-rounded value. 

Other types 

There are plenty of other display types available in Excel. Click the drop menu which is above the 

above mentioned icons for more options. 

 

Modifying data 

Now, let’s look at the example in the last exercise.  There are many 

ways to modify existing data in a cell, but first we must understand 

how data is actually displayed within cells. 

Let’s look at the data contained in cell reference A4. It’s contents is 

too large to fit completely in the A2 cell boundaries, but because 

there is no data in the adjacent cell to the right, the contents from 

A2 will automatically flow into the adjacent cell. If there was any data at all (including even a space) 

in B2, this would hide overflow data from A2 and only display the data from B2.  

The data contained in A2 has not been lost, only hidden. To display this data all you would need to 

do would be to widen the column – which is covered later on in this book. 

To modify existing data, you can either double click into the cell where you want to modify the data, 

or alternatively you can single click on to the cell you want to modify and then click into the formula 

bar and modify directly in the formula bar. 

Edit Mode 

You will notice that once you start editing, Excel will enter edit mode. While in edit mode, most of 

the ribbon functions and icons will be greyed out (not available).  You will also know you are in edit 

mode because a cross and a tick will become available next to the formula bar. (See image)  
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If you are happy with what changes you 

have made, then you can either hit the 

‘Enter’ button on the keyboard, or 

alternatively, click the tick icon. 

It can sometimes become tricky to edit 

long entries contained in cells, so another 

method of editing data is by single 

clicking into the cell to be changes, and 

then hitting the F2 (Function 2) key on the 

keyboard. This automatically turns on edit 

mode and then locates the curser at the 

end of the contents. 

Column widths and heights 
Sometimes it may be necessary to adjust the size of a column or row. You would usually do this to 

ensure data fits nicely in a cell. 

If it quite simple to modify a height or width of any given row or column. All you have to do is place 

your cursor over the top right label border between the row or column you want to adjust and the 

adjacent cell to the right or below. You will get a double headed arrow cursor. Once you see the 

cursor, then you can click, hold and drag the row or column to the height or width desired.  

 
 Adjusting column widths   Adjusting row heights 

You can also modify the column’s width automatically by double clicking between the column labels. 

This will widen the column to with width of the largest entry. 

Sometimes, you may want to have a group of columns or rows exactly the same size. You can do this 

by selecting the column or row labels and then right clicking and selecting the Column or Row Width 

option. 

Edit mode controls 
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Click & hold Let go here 

This will select the rows from B to F inclusive. 
This is how is 

should look 

Right mouse click on the 

column heading will bring up 

this menu and the select the 

Column Width… option 

This window will ask you what width you 

require. 8.43 is the setting of the default 

(current) width. Then Click OK. 

1 2 

3 

1 

2 
3 

4 
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Formatting the contents of a cell 
All of the following features are available from the Home tab in the ribbon. These options will only 

affect how your spreadsheet looks. Saying that, it is very important for you spreadsheet to look 

professional, and subtle use of colours is recommended. Very bold and bright colours usually will 

have the affect of removing credibility of the content of your spreadsheet – even if the content is 

accurate. 

 

 

Fonts / colours / sizes 

 

This drop menu will allow you to change the look (the font) of any selected cell or group of 

cells. Special consideration must be made as to keeping the data easily readable. 

This control will modify the size of the text within a selected cell. 

This feature will automatically increase or decrease the font size in a selected cell by one 

font size. 

The B icon will bold the data contained in a selected cell. 

The I icon will italicise the data contained in a selected cell.  

The U icon will underline the data. 

This control has two parts. The first part, the icon on the left hand side 

is the last used border control. By clicking this icon, it will apply 

whatever the icon option that is displayed. To choose a different border 

option, you will need to click the second part of this control, the down arrow 

to the right of the icon. This will give you the ability to select many different border 

display options. 

This option controls the colours of text and the highlight colours of text contained in cells. 

For example, this text has a different font colour, and this text has a different highlight 

colour. 

 

Font drop menu 

Font size 

drop menu 

Enlarge / Decrease 

font size 

Bold / Italic / Underline 

Cell border 

controls 
Font colour / 

highlighting 

1 

2 

3 

4 

5 
6 

1 

2 

3 

4 

5 
Part 1 

Part 2 

6 
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Clipboard 

 

 

 

The clipboard section of the Home tab controls the copy / paste functions in Microsoft Excel. These 

are features that are very frequently used, and behave exactly the same way as they do in other 

Microsoft Office packages. 

Cut 

When you have a cell or group of cells selected and click the ‘Cut’ icon, this will remove the selected 

cells from the spreadsheet and place them on the clip board. 

Copy 

The ‘Copy’ icon will place the contents of any selected cell(s) also onto the clipboard, but will leave 

the original data untouched – hence why it is called ‘Copy’. 

Data on the clipboard will remain there until you cut or copy an additional item. This new data will 

effectively overwrite the existing clipboard data.  

Another thing to remember about the clipboard is that the data stored on the clipboard is available 

to all applications on your computer, not just Microsoft Excel or Office software and visa-versa. It is 

completely feasible to select text from a web page, copy it and then paste it into a cell in Microsoft 

Excel or Word. 

Paste 

The ‘Paste’ option will write what ever the current clipboard data is into the selected cell(s). If you 

are unsure of the dimensions or number of cells a clipboard item may be, you can select a single cell 

as the top right starting point of the clipboard item in your worksheet, and then paste as usual. 

 

 

Cut 

Copy 

Paste 

Multi copy / Paste 
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Alignment 

 

 

 

The three options here control the horizontal alignment of data within a cell. Left, centre 

and right alignments. Be warned that if you centre align data, and it is too big for the cell, 

the data will automatically flow into both left and right adjacent cells. 

Vertical alignment controls where the data will appear vertically 

within a cell. Usually, a cell’s height is not modified and subsequently, 

the vertical alignment of a cell is rarely needed. If a cell’s height is 

increased, the data in the cell will remain at the bottom of the cell by 

default. (See image 1)  By selecting the ‘Middle Align’ option the data 

will change to image 2.  This option is used mostly when creating a 

heading or title to a spreadsheet. 

 

 

The text direction is used to change the direction of the 

displayed text usually from horizontal to another angle. 

See the image to the right. Notice how the days of the 

week are angled on a slant. You can also use this option 

to have text display vertically, like tear-off phone 

numbers on a flyer. 

Often, there are times when you want to control how text is displayed in a cell if it is too big 

for a single line. By default, the text will flow into adjacent cells and only display if the 

adjacent cell is empty. By selecting the ‘Wrap Text’ option you can control how data which is 

too big for a cell is displayed. By clicking the button, this will make the large text wrap onto 2 

or more lines. 

Vertical alignment 

Horizontal alignment 

Text direction 

Indentation 

Text wrapping 

options 

Merging 

options 

Alignment 

options 

2 

1 

3 

4 

5 

6

 

7 

1 

2 

3 

4 

1 

2 
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This little square box, once clicked, will open up the ‘Format Cells’ dialogue box. From this 

window, you can modify all the formatting attributes available in Microsoft Excel including 

all the controls outlined in this section. 

This option is very useful when creating headings or titles for spreadsheets. What it does is 

merge any selected cells and the centre it’s contents. See image 1 with the cells selected, 

and image 2 after clicking the ‘Merge & Center’ button. 

 

Indentation is a feature rarely used in Microsoft Excel. It works the same as in other 

Microsoft Office applications by moving the text (indenting) right a pre-determined space 

from the left margin of a cell. You can also decrease an indent by clicking the icon on the left. 

 

Inserting Objects (Images or Clip Art) 
You can insert pictures into your 

worksheets by going to the ‘Insert’ tab 

in the Ribbon and in the ‘Illustrations’ 

group you will find the options to insert 

a picture, Clip Art, Shape or SmartArt. 

The difference between a ‘Picture’ and 

a ‘Clip Art’ is that a picture is a digital 

image located somewhere on your hard drive. It may be your company’s logo, or a digital 

photograph you have taken. When you click the ‘picture’ icon (See item 1) a browse dialogue box 

will open up. Browse for the file you wish to insert and then click the ‘OK’ button. 

Item 2 (in the image) will enable you to insert a clip art image. Clip art images are pre-installed 

images available for you to use free of charge. These are great if you don’t have any images of your 

own. 

5 

6 

7 

1 - Before 

2 - After 

1 
2 3 
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Inserting shapes are a great way to add tips and other items to your page. By clicking on the ‘Shapes’ 

icon, see item 3, you will be given a vast variety of shapes and lines for you to choose from. Once 

you select the type of shape from the drop menu, then you will need to click and drag somewhere in 

a worksheet where you want the shape to appear. 

All images / clip art / shapes once inserted will allow you to 

modify their shape and size. 

You do this by clicking once on the image / shape and then 

clicking & holding and then dragging the re-sizing points. 

Be careful when re-sizing objects, especially photographs 

because it is really easy to drag a photograph out of 

proportions making it look silly. 

A way to ensure your image does not re-size out of original 

proportion is to hold down the ‘Shift’ key when you drag the 

bottom right re-sizing point. 

Once you insert an object, a whole set of new tools become available to you called the ‘Drawing 

Tools’. You will notice these when you single click an object. A orange ‘Drawing Tools’ tab appears at 

the very top of the ribbon (see item 1). Click on it to reveal many more options that give great 

control over your objects. 

 

Auto-fill 
This is a very useful feature of Microsoft Excel, and once mastered, it will become your best friend. 
The tool automated mundane tasks such as typing out the days of the week, or month and many 
other functions. 
 
 

 

Step 1 
 

Type in the text you will to 

auto-fill. In this example 

we will be auto-filling the 

days of the week 

Re-sizing 

points 

 

1 
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In the above example we did a horizontal auto-fill. This example and all others, auto-fills can also be 

dragged vertically so they will appear from top to bottom. 

Other auto-fills available by default include; 

• January, February... 

• Jan, Feb… 

• Mon, Tue… 

• Quarter 1, Quarter 2… 

• Qtr 1, Qtr2.. 

Step 2 
 

Place your cursor over the 

bottom right corner of the 

cell to be auto-filled. Your 

cursor will change to: 

 

Step 3 
 

Click & hold 

Drag to here. You will notice the little 

window telling you which day you are 

up to. 

Step 3 – Finished result 
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• 9 am, 10am… and many more. 

You also have the option to create other types of auto-fills. Microsoft Excel 

can recognise a pattern, and it will auto-fill according to that pattern. In 

the below image you can see different types of auto-fills. To create an 

auto-fill to your pattern, you need to create the first two entries, select 

both these cells and the auto-fill like normal.  

 

 

Type the first entry of each of these and then auto-fill them down. 

Click, hold 

and drag 

Result 

Have a go yourself! 
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Calculations 
Microsoft Excel is an exceptional application for working out complex mathematical equations. It 

strictly adheres to mathematical theory, the same that you will have learnt at school. One thing to 

note in an Excel equation (called a formula) is that the equals sign always appears at the left of the 

equation. 

Operators 
An operator in Microsoft Excel is a symbol that is used in a mathematical equation. Some look the 

same as the ones you know already, but others are slightly different. 

+ Addition, Adds one value to another (example: 20 = 10+10) 

_ Subtraction, minus one value from another (example: 10 = 20-10) 

* Multiplication, multiplies one value to another (example: 50 = 5*10) 

/ Division, dividing one number from another (example: 10 = 100/10) 

^ To the power of (example: 100 = 10^2) 

() Brackets are used in equations needing to implement BODMAS (example: 40 = (10+10)*2) 

BODMAS 
BODMAS are the instructions which enables us to know exactly the right 

sequence of doing things mathematically. In particular electronic calculators 

have to use a rule to know which answer to calculate when given a string of 

numbers to add, subtract, multiply, divide etc. 

Brackets 

According to the rule, the B, for brackets must always be done first. If there are 

multiple sets of brackets, the most inner brackets need to be done first. The 

brackets part of the BODMAS rule is the most often forgotten rule. Think of 

brackets as a way of isolating a particular part of an equation to ensure that 

part of the equation is worked out independently of the rest of the equation 

first. 

Order 

Order is actually a poor word to use here, “Power” would have been a better choice, but BPDMAS 

just does not have the same ring to it! Some secondary schools have substituted the O, for Order 

with an I for Indices, which is a more technical term meaning exactly the same thing. So if you know 

anyone in high school, they may refer to BODMAS as BIDMAS! 

If something is to the order of, it means to the power of. For example, 10 to the order of 2 is the 

same as 10 to the power of 2, which is the same as 10 squared (102). All these terms mean the same 

thing and they all equal 100! Another example would be 10 to the order of 3. This is really 10 cubed 

(103), which is 10 multiplied by 10 multiplied by 10 which equals 1000. 

BODMAS 

 

B – Brackets 

O – Order 

D – Division 

M – Multiplication 

A – Addition 

S - Subtraction 
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Division 

Division and multiplication have the same ranking in the BODMAS rule. You do each part of the 

equation as your read it from left to right. Division uses the forward slash key (/) on a computer and 

an example of this would be =40/10 and this would equal 4. 

Multiplication 

Again, this has the same ranking as Division and is calculated as your read it from left to right. 

Multiplication uses the Asterisk key (*) on a computer and an example of this would be =5*10 and 

this would equal 50. 

Addition 

Addition adds two or more numbers together. Like Multiplication and division, Addition and 

subtraction have the same ranking in the BODMAS rule and are worked out as you read them from 

left to right. An example would be =10+5 and this equals 15. 

Subtraction 

Subtraction minuses the second number from the first number. An example of this would be =10-4 

and this would equal 6. Like Multiplication and division, Addition and subtraction have the same 

ranking in the BODMAS rule and are worked out as you read them from left to right. 

You probably understand BODMAS already but just don’t know it as BODMAS. 

Here is an example of how you would use BODMAS in everyday life. Let’s say you make t-shirts for 

sale at the local markets. You buy your t-shirts in bulk from China for $4.50 each. You spend about 

$0.50 on paint and transfers for each t-shirt, so in reality, each t-shirt’s cost price is $5.00. Now, lets 

say you sell 10 t-shirts at $15.00 each. How much profit have you made? If you answered $100.00 

you are correct. 

Here are the formulas; 

 CP- Cost price ($5.00) = Wholesale price ($4.50) + Transfer & Paint ($0.50) 

SP – Sale Price ($15.00) – what you are selling the t-shirts for 

US – Units sold (10) 

Therefore the correct formula would be (Sale Price – Cost Price) * Units Sold. 

If there we no brackets in the above formula, the order the equation would be worked out would be 

incorrect and give a wrong answer. The brackets force the equation to work out what the profit per 

t-shirt is, and then it multiplies that amount by the units sold. If the brackets did not exist, the 

equation would first multiply the cost price by the units sold, and then minus this amount from the 

sale price of one t-shirt. 
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Simple formulas 
In Microsoft Excel formulas can be added directly into a cell by starting the equation with an equals 

sign. This is very effective at working out a very simple problem, but let’s says, if the values used in 

this equation need to be changed at a latter date. You would need to find the cell containing the 

equation, modify the cell’s contents while hoping not to make a mistake or delete other parts of the 

equation. 

A better way is to separate each of the formula’s elements into their own cells, and then work out 

the answer but not referring to the actual value contained in the cell, but the cell’s reference. The 

advantages of this method is that you can actually see the different parts of the equation which 

make up the overall answer, and also, you can modify the actual values and the formula will not be 

changed. Therefore, using this method, you can create dynamic spreadsheets which you can use 

over and over. 

You build your formula by first clicking in the 

cell you want the answer to appear. Then 

type in the equals sign. The next step is to 

make the equation. You need to open the 

bracket, then using your mouse, click into 

the cell reference A2, then hit the minus key 

then click into B2 then close the bracket. 

After this you need to insert the multiply operator (*) then using your mouse, click into the cell C3. 

Hit enter, and this will work out your equation. 
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Try these exercises. Type out this layout, then follow the steps. 

 

Have you missed anything? Once you have completed this task, save it as t-shirt_shop.xlsx. We will 

be using it latter in another exercise. 

 

Have a go yourself! 

Think border 

around the 

outside 

Solid colour in the 

background of the 

title 

Title is centred and the 

cells are merged. Font is 

Berlin Sans FB size 20. 
Titles have a 

different 

background colour 

Thin borders 

within the 

spreadsheet 

Format the columns 

appropriately 

Middle vertical 

alignment in these 

cells 

Click in this cell once. 

Hit the equals (=) sign 

on the keyboard. 

Excel now knows you 

are entering in a 

formula. 

Click in this cell once. 

This will let Excel know 

that is this the first cell 

to use in your formula 

Click in this cell once. 

This will let Excel know 

that is this the second cell 

to use in your formula 

Then hit the Enter 

key on the keyboard 

to complete the 

formula 

1 

2 4 

5 

 

 
 

 

Then hit the * key on 

the keyboard.  

3 

 
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Your spreadsheet should now look like this; 

 

 

Now, work out the remaining retail prices. This will be good revision of 

the last exercise. Once you have finished that, add the units sold. You 

can just enter these in link normal.  

After the units sold have been entered, we are now ready to work out 

the gross profit for each category. For the Plain White T-Shirts, the 

formula will be: =(D3-B3)*E3 

Work out the rest of the values for Gross Profit. 

All we have to do now is work out the total units sold by adding up the values in column ‘E’ and also 

the Gross Profit and Average sale price.  

 

Click into E10 and the click the equals sign (=) 

then mouse click into E3, then hit the plus (+) 

key, the click into the E4 cell, hit the plus key 

etc. Once you have all the cells in your equation, 

finish the formula by hitting the Enter key on 

the keyboard. This should give you 161. 

Do the same for the Gross Profit column. 

This should equal $2,372.50 
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The final part of this exercise is to work out the average sale price and have it display in the relevant 

cell in the spreadsheet. 

Follow these steps. 

 

And that’s it! The beauty of this spreadsheet is that the entries are dynamic. This enables you to 

modify prices and quantities, and the spreadsheet will still return you the correct answer. 

We’ll give it a go. The supplier in China has had to put their prices up. Enter the following data into 

your existing spread sheet. 

  New Wholesale Price Units sold 

Plain White T-Shirt $ 4.75 20 

T-Shirt with 1 Transfer (sml) $ 5.75 55 

T-Shirt with 1 Transfer (lge) $ 6.25 19 

T-Shirt with 2 Transfers (sml) $ 6.50 12 

T-Shirt with 2 Transfers (lge) $ 7.25 17 

Sweat-shirt with transfers $ 14.95 40 

Jumper with painted picture $ 27.50 16 

 

What was your overall profit? ____________ 

What was your average sale amount?______________ 

From this, you may identify a need to modify your mark-up percentages and lower them to help 

keep your retail prices to a minimum. From a business point of view, this is called absorbing costs – 

something businesses try not to do too much! 

Once you have completed this exercise, click the save icon and close the file down. 

First, click where you want the answer to 

appear, in this case the F12 cell. Start the 

equation by hitting the equals key (=). 

Now, single click into the total gross profit, cell 

(F10). Enter the Divide operator (forward slash 

key on the keyboard - / ), then single click into 

the total units sold cell reference (E10). Finish 

the formula by hitting the Enter key on the 

keyboard. 

The correct answer should be $14.74. 
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AutoSum Button 
The auto-sum is one of those magnificent functions you will come to love. It automates many tasks 

in Microsoft Excel. The actual function of auto-sum is only one of many handy little functions that 

are grouped together in this icon.  

 

There are two parts to this icon which is located on the Home tab of the ribbon. The first part, the 

left hand side of the icon will, when clicked apply the AutoSum function to wherever the selected 

cell is. If you want to use one of the many other functions, you will need to click the down arrow on 

the right side of this icon. As you can see fro the above image, there are many features available, 

and we will be going over some of them in this part of the manual. 

Essentially, to AutoSum is to add a group of numbers up. When clicked, the function will look for two 

or more or more subsequent numeric values above the selected cell. If two or more values don’t 

exist, the function will look horizontally for values to add up. Once it identifies some values to added 

up, it places a dotted line around the values it predicts you wish to have added. Be careful that you 

actually check where Excel is predicting because it may include values you were not indenting to 

include. 

 

 

 

Have a go yourself! 

Type these figures out onto a 

new workbook. 

Type this data out on a new sheet 
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This will have automatically added up all the numeric values in Row 2. The actual function will look 

like this: =SUM(B2:G2) 

By placing the word SUM after the equals sign, it instructs Microsoft Excel to call one of it’s inbuilt 

functions, the Sum function. The two references separated by a colon mean to include all references 

from the first reference cell to the second reference cell. 

For example =SUM(B2,C2,D2,E2,F2,G2) is exactly the same as writing =SUM(B2:G2). I know which 

one I’d prefer to use. 

Now continue on with doing the second row, and then the third etc. 

 

 

 

 

Time to use Auto-fill 

This is also a great time to use Auto-fill. You really only need to complete the total for the Coffee 

sales. Once the answer is in the cell, click and drag the auto-fill handle down line in the previous 

exercises and it will actually automatically complete the rest of the equations. 

Continue… 
Click into this cell (H2) 

Click the AutoSum icon 
Make sure the dotted line is only 

selecting the values you want to 

add up 

Click Enter to finalise 

1 

2 

3 

4 

Continue… 

Be careful once you are up to the third row 

as there are now two values available 

vertically. The AutoSum looks vertically first 

by default.  

You will need to re-drag  to select new 

values to use in the AutoSum function. 



25 

Author: David Auld 

Another way! 

Another method of using the AutoSum button, and probably the quickest and best way is to select 

all the cells on the spreadsheet up and including where you want the answer to go. 

 

 
 

 

 
Now, if you had know about the AutoSum function earlier, the exercise which required you to add 

up all the totals would have been much easier. 

Open up the previously saved spreadsheet t-shirt_shop.xlsx. Delete all the total values like the image 

below. 

 

Using the AutoSum function, you should be able to work out all the totals in this spreadsheet in two 

(2) clicks! 

Once all the cells are selected (including where 

you want the answers to go) then single click the 

AutoSum icon. 

The result 

Have a go yourself! 
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Absolute Vs Relative referencing 
So far during this manual you have been applying relative referencing without even knowing it. 

Relative referencing is the most common 

of all references in Microsoft Excel. 

To explain how it works, let’s look at 

example 1. 

The formula to work out the amount o 

Super is the Gross Income multiplied by 

the super rate. 

You can actually see the referencing my 

having the cell D5 selected (where the 

formula is in the image) and then going 

to the Formulas Tab, then clicking on the 

Trace Precedents button.  (See example 2) 

 

 

 

Result! 

Example 1 

Example 2 

Result 
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Currently there is no problem with our formula. The logic (the maths) is correct, and it has given us 

the correct answer. Currently the referencing is relative. 

A relative reference is one which is understood by 

Microsoft Excel as being a specific number of cells from 

the cell which contains the formula. In our 

superannuation example Microsoft Excel does not pay 

much attention to the actual cell references contained 

in your formula, rather, their relative reference. 

Therefore to Excel, the equation is =1 column to the left 

* 1 column left and 4 rows up. 

You are probably asking why this is so important because up until now, all of our equations have 

worked. Well, referencing only becomes important when using the AutoFill option on your 

equations. 

Let’s look back at one of our earlier spreadsheets. 

 

The reason the AutoFill worked is because in the first answer all the cell references were in the 

correct position on all the subsequent AutoFilled cells. They were all calculating what 6 columns to 

the left through to 1 column to the left added up to. These were all relative referenced cells. 

Turning out attention back to our Superannuation spreadsheet, let’s see what happens if you try to 

AutoFill the answers. 

As you can see by the result, we ended up with an 

answer we may not have been expecting, and obviously 

it is incorrect. 

The result under Fred Bloggs’s Super amount has a value 

of  ‘$        -‘. As sated earlier, this is because the cell 

references being used to calculate the answer are 

referred to relative from the cell which will display the 

By clicking and dragging the AutoFill 

handle, it automatically copied the 

formula down. 

Before 

Result 
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answer. In this case, the formula will be looking for one column left and 4 rows above multiplied by 

one column to the left.  

We need some method of locking a value so it does not move when being auto filled.  

Create an Absolute Reference 
It is time to create an absolute reference! As demonstrated in the examples previously, there are 

times when you need to lock a cell’s reference so it will not accidently move during an auto fill task. 

There are various ways to create an absolutely referenced cell, but we will show you the two most 

common ways. 

Using a shortcut key 

To use a shortcut key, first you must identify the 

cell in your equation which you wish to absolute 

reference. 

Pay particular attention the formula. In the 

previous example, the superannuation rate cell 

C2 is the cell in the equation needing to be 

absolutely referenced.  At the moment, the 

formula is relatively referenced.  See step 1. 

Now, in the formula bar, we need to click on the 

cell reference in the formula bar we wish to 

absolutely reference. The cursor can be either 

before the ‘C’, or in between the ‘C’ and the ‘2’ 

or after the ‘2’. As long as the cursor is touching 

the cell reference. See step 2. 

The final step of this is to click the ‘F4’ key.  This 

will place a dollar sign before each portion of 

that cell’s reference. There will now be a ‘$’ 

symbol before the column reference ‘$C’ and 

also a ‘$’ symbol before the row reference ‘$2’. 

This is telling Microsoft Excel that the cell can 

not be auto-filled either horizontally nor 

vertically. See step 3. 

If you keep hitting the ‘F4’ key, this will cycle through all the different references available. This 

other references are called partial references and are covered in more advanced classes.  

 

Selected cell 

Notice how my cursor is on the 

cell reference I wish to 

absolutely reference. 

Notice how the cell 

reference has changed. 

F4 

Step 1 

Step2 

Step 3 
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Creating an absolute reference manually 

Creating a manual absolute reference is exactly the same as the above procedure, but instead of 

hitting the ‘F4’ key, you actually manually type the dollar signs ‘$’ where you require them in the 

formula bar. 

Linking 
Linking is a feature that is useful if you require the value of one cell from a different worksheet or 

even different workbook to appear in your worksheet. 

This task is achieved by clicking into the cell where you want the linked value to appear, then clicking 

the equals sign ‘=’. You will now need to navigate to the worksheet that contains the cell you wish to 

from. You now need to single click into the cell and then click the ‘Enter’ key. 

This will produce a cell reference as illustrated in the below image. 

 

In this reference, the cell ‘B3’ (see item 1)– the selected cell is displaying the contents of a cell which 

is located on the ‘Darwin City’ sheet (see item 2) at a cell reference of ‘B6’ (see item 3). 

 

 

Create a set of worksheets for a franchise computer sales / repair company. 

Create each of the below sheets. Change each of the worksheet tabs to be the same as the location 

of the franchise business. You can change these by right clicking on the tab you want to change, and 

then select the option to rename. 

1 

2 

3 

Have a go yourself! 
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Now, we need to link up all the individual store information onto the Summary worksheet. 

Click into this cell. This is the cell 

we want the Qtr 1 sales from the 

Darwin City store to appear. 

Click the equals sign (=) 
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By clicking the equals sign, you will place the cell into edit mode. Not only can you create your own 

formulas and equations, but you can also tell Microsoft Excel to display the contents of another cell 

(Linking) in the selected cell. 

After you have clicked the equals sign, you must 

now navigate to the worksheet containing the 

information you wish to link to. In this case, we 

will click on the Darwin City tab. 

Next you will need to select the data source that 

will appear on the summary sheet. 

Single click into the Qtr 1 total cell (B6) 

Notice the formula bar now shows a relative 

reference to the cell B^ on the ‘Darwin City’ sheet. 

The last thing you need to do is hit the ‘Enter’ key 

to complete the link. 

Select the cell 

Start the link 
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When ever the data changes in the linked cell contained on the Darwin City tab, the data also 

changes on the Summary sheet. 

Another benefit of linking is that they can also be relative or absolutely referenced. By default, a 

linked cell will be relatively referenced - =’SheetName’!A1. You can absolutely reference a cell 

reference in a linked formula exactly the same way as specified in the referencing section of this 

manual. An absolutely referenced linked reference would look like this - =’SheetName’!$A$1. 

As the default reference of a linked item is relative, and also because the ‘Darwin City’ sheet is laid 

out horizontally just like the summary sheet, you can auto-fill each of the quarters for each location. 

You can not auto-fill vertically in this sheet because auto-fill does not understand the required linked 

reference is on a different sheet. So, all you need to do is link the Qtr 1 value for each of the 

locations, and then auto-fill them across to the total column. 

  

 

 

 

 

 

 

The final result 

By selecting all of the 

rows at once, you can 

auto-fill all four 

locations at once! 

Time to Auto-Fill 

Result from your first link! 
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Once you have done this, then all is left to do is AutoSum the total of each of the Qrt columns, then 

you have finished. It should look something link the graphic below. 

 

Links on different workbooks 

Links can be even across different workbooks (different Microsoft Excel files). All you need to do is 

have both workbooks open and when navigating for the linked cell, first go to the different 

workbook, then the correct worksheet and then finally, the required cell. 

Updating links on different workbooks 

By doing this type of link, each time you open your spreadsheet, you will be asked if you want to 

update the links on the remote workbook. If you say yes, Microsoft Excel will check the linked from 

file, see if there are any differences (if the values have changed since the last time the file was 

opened) and then apply the values to the receiving workbook. If you say ‘No, you don’t want to 

update’ then you workbook will use the last known values from the link. You can update the linked 

values at any time by going to Data tab in the ribbon and then selecting the Edit Links option. In this 

dialogue box, click the ‘Update Values’ button. 

 

The final result 
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Conditional Statements 
Conditional statements are a very useful tool in Microsoft Excel because they enable us to 

differentiate between particular values and depending on a particular values, display a response 

depending on that value. 

Conditional statements are also called ‘If Statements’. If statements form the basis of many a 

computer program and are in all computer programming languages. 

Theoretically speaking, there can only be two possible results from a conditional statement; true or 

false. 

Lets look at this example. You want to create a program which judges how a coffee tastes. 

Here is the conditional statement; 

If the coffee = “Bad”, then “Ask for your money back”, or else “Smile and be happy” 

The conditional statement is the portion coffee = “Bad”. The true response, that is if the coffee is 

Bad, would be “Ask for your money back”. If the statement was not true (ie False) then the response 

would have been “Smile and be happy”. 

The correct way to write (syntax) an conditional statement in Microsoft Excel is below; 

=if(logical_test,true_response,false_response) 

Therefore, to write the coffee example would be; 

=if(coffee=”Bad”,”Ask for your money back”,”Smile and be happy”) 

The above statement is quite straight forward, but it is not very flexible. What if you received a 

‘Crap’ coffee (which I’m sure we all have from time to time). What response would you expect our 

conditional statement to respond with? If you chose the option “Ask for your money back” you 

would have been incorrect. The reason for this is the actual conditional statement is very specific 

and does not lend it’s self to any human judgment or flexibility. All the conditional statement is 

checking is whether any supplied option is the same as “Bad”, and Crap and Bad are not the same – 

according to a computer anyway. 

As a Microsoft Excel operator, problems like this often arise. You will need to think of a better way of 

doing things. A much better way of testing the quality of a coffee would be to come up with some 

sort of numeric scale, like 1=Very Bad through to 10 = Excellent. Your conditional statement would 

now look something like this; 

=if(coffee<6,”Ask for your money back”,”Smile and be happy”) 

By using this type of conditional statement, all values 5 and below will be true and return the 

expected response. Any value above 5 will return the response “Smile and be happy”. 
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Keep in mind 

Some things to note; where the word coffee is in the above examples, this would actually be a 

reference to a cell on a worksheet (eg. A4).  

Where numbers are used in the logical test, they do not need to be contained within quotation 

marks. Any strings of text must be contained within quotation marks. 

You can use any of the below operators in your conditional statements; 

=  Equal to 

< Less than 

 > Greater than 

 <= Less than or equal to 

 >= Greater than or equal to 

 <> Does not equal 

 

 

Create the below spreadsheet. 

 

In the cell B4 we are going to insert the conditional statement. So we can see a result immediately, 

we will start off by placing a value in the cell reference B1. Place any number between 1 and 10 in 

cell reference ‘B1’. 

Then we will select the cell B4 and type the below conditional statement (see item 1); 

=if(B1<6,”Ask for your money back”,”Smile and be happy”) 

Have a go yourself! 
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Once you have entered the above text, you will need to finalise the formula by hitting the ‘Enter’ 

key. You will now notice the conditional statement working. Try changing the value for the Coffee 

Quality and watch how the value where the conditional statement changes. (See item 2) 

 

What if we wanted to make the conditional statement more accurate. Let’s say we wanted two 

options for bad coffee’s; “Ask for money back” and “Never go back” along with the usual “Smile and 

be happy”. Well, we can do this by nesting an additional if statement in the true portion of the 

original statement. Consider the below statement; 

=if(B1<6,if(B1<4,”Never go back”,”Ask for your money back”),”Smile and be happy”) 

 

 

The benefits of these types of statements should be apparent. It will give you the option of multiple 

variable responses. You can also ‘nest’ other types of functions. We will look at this latter in the 

manual. 

Item 1 

Item 2 

This is the new ‘nested’ portion of the 

original ‘if’ statement 
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Conditional Formatting 
Conditional formatting is similar to conditional statements because it looks at a cell’s value and then 

depending on the value will apply specified cell 

formatting using colours. 

For example, a very common use for the 

conditional formatting would be in a P&L 

statement (Profit / Loss). Any value below zero 

(0) is usually written or displayed in red. 

As an example, on our linking document I have 

added some expenses. Hopefully, most 

businesses don’t run in the red (at a loss) but 

there are times when businesses do run at a loss 

for one reason or another. In our example the 

Darwin City store was re-fitted in the 1st quarter 

at a cost of $250,000. In the 2nd quarter the Bees 

Creak store was also re-fitted at a cost of 

$150,000. This has subsequently meant that 

those two quarters were run at a loss. 

To apply conditional formatting to the Cash Flow and Profit / Loss cells, we 

need to do each individually. So, single click into the Cash Flow of Qtr 1. Then 

click on the Conditional Formatting option from the Home tab of the ribbon. It 

will drop down a menu (see item 2) 

Select the Highlight Cells Rules and then select the Less than…” option. This will 

open a new dialogue box where we can specify the rules of when to apply the 

conditional formatting. (See item 3) 

 

 

 
 

 

 

 

Item 1 

Item 2 

Item 3 

Insert the value $0 here so 

any value less than $0 will 

apply the formatting 

outlined in the drop menu to 

the right. Then click ‘OK’ 
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Now go through and do the rest. 

There are plenty of different conditional formatting options available, and you can even add more 

than one format to a particular cell. 

 

V-lookup / H-lookup 
V-lookups are the most common form of a lookup. The ‘V’ stands for Vertical and the ‘H’ stands for 

horizontal. They both do the same thing, just one vertically (the most common) and one horizontally. 

What does a V-Lookup do? 

Well, they make your life simpler by 

automating tasks. They do this by 

comparing a value in your spreadsheet 

with a list of values in a data set. Think of 

it as just having to enter a product code in 

a spreadsheet, then the V-lookup 

compares the product code to all the 

products available from the catalogue (the 

data set) and then returns the required 

information about that product into your 

spreadsheet automatically.  

In the image to the right, all you will need 

to do for each new item is enter the 

Product Code and then the quantity (Qty) 

and the spreadsheet will work out the 

rest. The V-Lookup will find the description of the product and place it into cell reference ‘C8’, 

another V-lookup will find the unit price and automatically place it into the Unit Price cell. Your 

spreadsheet will then multiply the unit price with the quantity to find out the Total Price and then it 

will divide the total price by eleven (11) to work out the GST component. 

Result 
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Finally, the spreadsheet will total all the Total Price amounts and all the GST amounts and display 

the results at the bottom of the spreadsheet. 

 

 

First, make this spreadsheet. (see item 1) 

 

Next, on another sheet, make this dataset of products. 

Code Description Unit Price 

1 Hard Drive, 500Gb, SATA2 $159.00 

2 Hard Drive, 1Tb, SATA2 $299.00 

3 Hard Drive, 1.5Tb, SATA2 $379.00 

4 RAM, DD2, PC800, 1Gb $29.00 

5 RAM, DD2, PC800, 2Gb $39.00 

 

It should look like this: 

 

 

 

Have a go yourself! 

Item 1 
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Notice in item 2 that I have placed a boarder around many more rows than the data we entered. 

This is so at a later stage we can added additional items to our dataset. 

Looking at our dataset, we need to identify which column is which. As mentioned earlier, Column 1, 

in this case the ‘Code’ column is the index from which a match will be made. The ‘Description’ 

column is Column 2, and the ‘Unit Price’ column is column 3. 

It is at this point we need to name our dataset. By naming the dataset, we will be able to identify the 

dataset easily when completing the V-lookup function. Think of a name you will remember and that 

describes the dataset. For this example, I will call the dataset ‘products’. 

The process of naming a range (which is covered in more detail later in the manual) is quite simple 

and only involves a few steps. 

Step 1 

Select the dataset making sure you don’t select the labels at the top of each column. (See item 3) 

Notice that I have also selected the blank areas of data where items may be entered in the future. 

 

 

 

Item 2 

Column 1 

Column 2 

Column3 
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Step 2 

Type the word ‘products’ into the Name Box and then hit the ‘Enter’ Key. You must finalise this 

action by hitting the ‘Enter’ key or else the name you have called the dataset will not have been 

saved.  You will also know it has been entered correctly because it will be centred in the Name Box, 

while at the same time the dataset will be correctly selected. (See item 4) 

Item 3 

Item 4 

Notice the word ‘products’ is 

centred, while at the same time the 

correct dataset is selected. 
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Step 3 

You can check that it all worked correctly by unselecting the dataset (by clicking once anywhere 

within the spreadsheet) then go back to the Name Box, click the drop arrow on the right hand side of 

the box and select the item ‘products’. This should then select the dataset including all the blank 

rows. 

If it (the word ‘products’) does not appear in there then it was never finalised properly and it will 

need to be done again. (Back to step 1) 

If the word ‘products’ exists, but it is not selecting the dataset correctly, then the name will need to 

be deleted first, then done again. 

Deleting Names 

To delete the name you need to go to the ‘Formulas’ tab in the ribbon and then click the ‘Name 

Manager’ icon. This will then open up a new dialogue box. You will then need to single click on the 

incorrect name, then click the delete button. (see item 5) 

Item 5 

Click here to 

open the Name 

Manager 

Select the 

incorrect name 

Click here to 

delete the name 

from the list 

Click here to 

close the 

window 

1 

2 

3 

4 
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Enter a V-lookup 
Now, once we have set up the initial invoice template, and then the named products list, we can 

start on setting up the invoice template so it becomes completely dynamic. We will do this by adding 

the previously mentioned V-lookups and some basic formulas. 

When ever doing this sort of function in Microsoft Excel, it opten helps to have some sample data in 

the spreadsheet before we start. This will make the process of entering the functions slightly easier 

because it will give you results immediately during the creation process. 

So, I will start by entering a number ‘1’ into the ‘Product Code’ cell, (A8) and also a number ‘2’ into 

the Qty cell (B8). 

We now need enter our very first V-lookup. This V-lookup will be retrieving the Description of a 

matched item.  Follow the below steps. 

Step 1 

Click into where you want the result to go (in our case the cell reference C8) 

  

Step 2 

Now click on the ‘Formulas’ tab on the ribbon, click on the ‘Lookup & Reference’ Icon and select V-

lookup. See item 2. 

Item 1 
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This will open a new dialogue box, see item 3. 

 

 

Item 2 

Click on the 

Formulas tab Click on the Lookup & 

Reference tab 

Select the 

VLOOKUP 

option 

1 
2 

3 

Item 3 
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Step 3 

We now need to enter the data into the Function Arguments dialogue box (item 4). 

The first field, the Lookup_value is where the cell reference to the Product Code will go. It 

will be the value used to compare against the values in the dataset. All you need to do is 

click into the field, then click into the ‘Product Code’ cell on the invoice spreadsheet (A8) 

The Table_array field is where you will type the name of the dataset, in our case we will type 

‘products’ 

The Col_index_num is the number of the column within the dataset that is to be returned. If 

we remember back to the earlier part of this exercise, we numbered the columns, ‘1’ being 

the first column, ‘2’ being the Description column and ‘3’ being the unit price. Because we 

are wanting the description to be returned for this instance, we will enter a number 2 in this 

field. 

The final field, the Range_lookup is only used if an exact match is required. By default and if 

left blank, the option will be true. By placing the word ‘false’ into this field it forces the v-

 lookup to only return a match if an exact match is found. Using the default option of ‘true’ or 

 leaving it blank will make the v-lookup find the closest match. For example, if tax scales are 

 used, the v-lookup will find the row from the dataset that is within the correct range, for 

 example if a taxable income is $540, and the data set has a row at $500 and then another 

 row at $550, then the v-lookup will return the result for the $550 row. 

 
Here’s a tip when entering the Table_array. If you have forgotten what or how you spelt your 

dataset name, a simple shortcut is to place your cursor into the Table_array field and then hit the F3 

key on the keyboard. This displays all the range names contained on the active workbook. Select the 

correct range name from the list and then click OK. 

1 

2 

3 

4 

1 

2 

3 

4 

Item 4 
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Let’s check the result before we finalise the lookup function. 

You may have noticed that as you were entering the above information into the function arguments 

dialogue box data was appearing to the right hand side of each field as you entered information. This 

is because you already had data in the spreadsheet before we started.  (See item 5) 

You may have also noticed the actual answer at the bottom of the function arguments dialogue box 

where it has the words ‘Formula result = ‘.  

You should expect the correct answer to appear here before clicking the ‘OK’ button. 

 

Now click the ‘OK’ button and the result should appear in your ‘Invoice’ spreadsheet. 

 

To see how it works, change the value ‘1’ to something different, let’s say, change it to the value 5. 

 

Item 5 
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Complete the invoice form 

What we need to do now is complete the invoice spreadsheet. To do this we now need to create 

another V-lookup to find the unit price of the product. This is done exactly the same way as the last 

example, but the V-lookup function is created in the Unit Price cell, and it will return column three 

(3) from the ‘products’ dataset. 

Once these two v-lookups are complete, you spreadsheet should look similar to item 6. 

 

Now we need to work out the total price for the item. This is simply the Unit Price multiplied by the 

Qty. (See item 7) 

 

Now we need to work out the GST component of the Total Price. This is done by dividing the Total 

Price by 11. (See item 8) 

 

Item 6 

Item 7 

Result 

Item 8 

Result 
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For the rest of the invoice form to work, you will need to Auto-Fill Description, Unit Price, Total Price 

and GST columns down to the bottom of the item area. You will get some unexpected results 

appear. (See item 9) 

 

The reason for these #N/A errors is because the V-lookups are trying to compare a value of nothing 

(the empty cells in the left hand side of the invoice form) to the values in the products dataset. The 

V-lookup requires the lookup value not to be null or empty. 

This is where the good ole nested functions come into it again. 

How about we do a logical test to see if there is in fact a value in the lookup value. If there is, then 

do the V-lookup as normal, but if it is blank, then display nothing. 

Here is the pseudo-code: 

=if(Product Code is blank, “Do Nothing”,”Do the V-lookup) 

OK, so here is the real nested function; 

=if(ISBLANK(A8),””, VLOOKUP(A8,products,2)) 

 

 

Item 9 

Logical 

test 

Display nothing if true 

 

Continue with the expected 

V-lookup if false 
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If it is all functioning correctly you should be able to add products anywhere on the invoice form and 

it should still work. 

The last thing we need to do is AutoSum the Total Price and the GST into the ‘Total’ cells at the 

bottom of the spreadsheet. Once this has been completed it should look similar to item 10. 

Without the nested logical test for blank fields, the AutoSum totals at the bottom would not have 

worked. AutoSum can not add up #N/A because it is not a number. 

 

 

Item 10 
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Insert Function dialogue box 
The ‘Insert Function’ dialogue box is a throw off from Office 2003 days, but still exists. In Microsoft 

Excel 2007, all of the commonly used functions are available from the ‘Formulas’ tab on the ribbon. 

What happens if the function you want does not appear on the ribbon or one of it’s sub-menus? Or, 

lets say you want to browse the available functions. This can all be done by clicking the ‘Insert 

Function’ icon from either the very left hand side of the ‘Formulas’ ribbon (1), or by clicking the Fx 

icon to the very left of the formula bar (2). (See item 1) 

 

Sorting & Filtering 

Using the ‘Sort A-Z’ button 

Custom sorting 

Filtering 
 

Once you click either of these icons the ‘Insert Function’ dialogue box will appear. (see item 2) 

 

You can search for a particular function in the top section, or use the drop menu to browse by 

category, or if you select the option ‘All’ in the drop menu, you can then browse every function 

1 

2 

Item 1 

Item 2 
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available in Microsoft Excel. Once you select any function with a single click, a description of what 

the function does appears underneath the scroll window. 

Once you are happy with your selection from the ‘Insert Function’ dialogue box, the specific function 

arguments for that particular function are then displayed. Each function will require different 

entries.  

Charting 
Much of what Microsoft Excel is about is being able to produce meaningful charts for reports and / 

or statistical analysis. 

A chart is a graphical representation of a large quantity of data, compiled in a way that anyone can 

easily understand and appreciate without any real knowledge of the raw data from which the chart 

has been produced. 

There are many kinds of charts available to you in Microsoft Excel and many of these chards can be 

produced in as little as 3 or for clicks! 

Don’t forget to correctly label your charts with titles, and axis labels. Sometimes a axis label is not 

required. 

 

 

 

 

 

 

 

 

 

 

 

 

Chart Title 

X Axis 

Y Axis 

X Axis series titles 
Y Axis 

scale 

Y Axis title 

Series 

data 

columns 

Plot area 
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The three main types of charts covered in this manual are; Bar graph, Line Graph and Pie Chart. 

Bar Graph 

These can be vertical or horizontal (see item 1&2).  The two 

items show exactly the same data but displayed as a column 

graph (item 1) and as a bar graph (item 2). It is really down 

to personal preference as to which type you use, but 

remember, you should use a format that your audience is 

expecting. 

A bar graph’s primary purpose is to display the distribution 

of a selected number of items against a set scale over a 

single time period. The selected number of items does not 

need to be every item from a list, rather only the specific 

ones which need to be analysed. 

These graphs can also be used to demonstrate the 

distribution of items over more than one time period, but a 

line graph is much better suited for this purpose.  

 

 

Line Graph 

Line graphs are the most common type of chart you would 

come across. They are used for comparing one or more 

values over a given time period. For example, line graphs are 

used extensively in the stock market (see item 3) tracking 

one or more stock’s rise and fall over time. Because each 

entry is linked to the previous entry and so on, a visible trend 

over time can be established. 

As you can see from the example from the Australian Stock 

Market, a single commodity is being tracked every minute 

since 10am. The line between each of the recordings enables 

a person can draw a conclusion from the ‘picture’ it 

represents or give an accurate account 

of what has happened in the past. An 

excel line graph can be as complex or as 

simple as required, but they (line 

graphs) all do the same thing. They 

show trends over time. The example 

item 4 is an Microsoft Excel line graph 

showing four items being tracked. 

Item 1 

Item 2 

Item 3 

A screen shot from the Australian Stock 

Market web site http://www.asx.com.au  

Item 4 

http://www.asx.com.au/
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Pie Charts 

A pie chart shows the distribution of a whole dataset for a single 

time period. Pie charts give a very easy way to understand 

distribution of a number of items. From the example item 

5, you can easily tell that Orchards are by far the biggest 

income generator during the 1st Quarter. 

 

 

OK, how do we make one? 

 

Simple, first we need some data. I will use the data from the bar graphs illustrated previously. 

 

 

Open a new workbook and create a spreadsheet with the following 

data outlined in step 1. 

So Microsoft Excel knows what data to use when creating any chart 

or graph you must have it selected. 

TIP - Sometimes the data is not in adjacent cells, so to select non-

adjacent cells you must first select the first group, then hold down 

the Ctrl key and then select the other data source. 

Now, select the data labels and the actual numeric data to be used in 

the chart. Pay particular attention not to select the title.  

(See Step 2) 

The next step is to go to the ‘Insert’ tab on the ribbon and here you 

will find all the different charting options. (See Step 3) 

 

 

 

Item 5 

Have a go yourself! 

Step 1 

Step 2 

Step 3 
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The first type of chart we will make is a vertical column chart. So, the next step is to select the 

‘Column’ icon. This will give you a drop menu which shows all the different types of column graphs 

available. For this exercise, we will select the ‘2D Clustered column’ option. (See Step 4) 

 

 

Once you click the icon outlined in step 4 a chart will 

appear on your spreadsheet. (See Step 4 Result) You will 

notice the chart looks pretty good and is what we 

expected, but on closer examination you will notice it could be a little better. For example, it is 

missing a chart title. Also, the label ‘Series 1’ has no real purpose so it can be deleted. 

Let’s delete the Series 1 label. First single click on the label and dots will appear around the label. 

Now, hit the ‘delete’ on the keyboard. (See Step 5) 

 

 

 

 

 

 

We now need to add a chart title. Firstly we need to make room on the chart for the title. We do this 

by single clicking on the plot area and this will bring up the little circles (re-sizing anchors) on the 

Step 4 

You should 

already have the 

data selected 

You should 

already be on the 

‘Insert’ tab 

Click on the 

Column icon 

Then select the 2D 

Clustered Column option 

1 

2 

3 

4 

Result 

Single click the 

series label 

1 

Step 5 Result 

Then hit the ‘Delete’ key 
2 
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corners of the plot area. Click and hold the top anchor (You will get a double headed arrow cursor) 

and then drag it down a little, just enough to make room for the chart title. (see Step 6 & result) 

 

 

 

 

 

 

 

  

We now need to add a text box where the title will go. You can find the ‘Text Box’ icon in the ‘Insert’ 

tab of the ribbon.  Click and drag an area on the 

chart where you want the title to go. (See Step 7) 

Once you let go, a text box will appear where you 

can add your chart title. For this exercise we will 

type in: ‘Sales Qtr 1 2009’ and then format it 

appropriately. 

You may have also noticed the when ever you 

have a chart selected, and ‘Chart Tools’ option 

appears at the very top of the application. (See 

below) 

 

 By clicking this option it opens all the tools and 

option available to modify the selected chart. 

 

Step 6 

 Click, hold & Drag 

Result 

Step 7 

Drag an area 

for the chart 

title to appear 

Result 
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Let’s create a Pie Chart 

We will use the same data that we used to create the column graph in the previous exercise but this 

time we will make a pie chart. 

The creation process is nearly exactly the same, but instead of selecting ‘Column’ icon from the 

‘Insert’ tab of the ribbon, you will select the ‘Pie’ option instead. 

 

 

Follow these steps; 

1. Select the data source including each label 

2. Go to the ‘Insert’ tab on the Ribbon 

3. Select the ‘Pie’ option and select an appropriate type of pie chart 

4. Add a title 

You should have a chart looking similar to the below example. 

 

 

 

 

 

 

 

 

You can add data labels by right clicking on the pie chart and selecting the 

‘Add Data Labels’ option. This gives you the ability to show other 

information on the chart. Data labels may enable you to create a pie graph 

which is easier to understand. You may need to format the data labels to 

get them to look exactly how you want. You can also click and drag the 

labels to where you want them to appear on your chart. 

Currently our charts are displayed as objects within a 

worksheet. You can make them appear on their own sheet 

Have a go yourself! 
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by going to the ‘Chart Tools’ area and clicking the ‘Move Chart’ option. (See item 1) 

 

 

 

 

 

 

 

 

Item 1 

Click the Move Chart option 

The ‘New sheet’ option 

will make the chart move 

onto it’s own sheet 

Result 
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Assessments 

Certificate I Assessment 
 

This assessment will cover all the requirements of the unit’s performance criteria and will be based 

on several  spreadsheets you would be likely to come across in everyday business situations. 

It will include a rainfall page, pay roll sheet, and a payroll summary chart. 

The assessment must be submitted as one (1) workbook, which includes three named worksheets. 

These worksheets are to be named: Rainfall, Payroll and Summary. 

The assessment must be submitted with a cover sheet and a print out of your pie graph. The excel 

file is to be emailed to your lecturer by the due date with your name, student number and 

ICAU1130A Assessment as the subject. 

Part 1 (performance criteria 1.1,1.4, 1.5, 1.7, 2.1, 2.2, 2.3, 2.4, 2.5, 2.6, 3.1, 3.2, 3.3, 3.4, 3.7) 

 

Create a spreadsheet that is formatted the same and containing the below data. It must include the 

borders, cell fill backgrounds, cell formatting and the answers to the empty cells. 

You will need to total the rainfall for each suburb, and also for each month. At the end of each 

column and row you are to calculate the Average rainfall, the maximum rainfall and the minimum 

rainfall during the 12 month period. 

  

Part 2 (Performance criteria 1.1, 1.2, 1.3, 1.4, 1.5, 1.6, 1.7, 2.1, 2.2, 2.3, 2.4, 2.5, 2.6, 2.7, 3.1, 3.2, 3.3, 3.4, 3.5, 3.6, 3.7, 

4.1, 4.2, 4.3) 
 

Create a worksheet which will be used as a pay roll for a fictional company. This spreadsheet is to 

include an image (any) positioned in the top left of the spreadsheet and resized to not take up any 

more than 5 standard sized rows. 

The spread sheet must be able to be changed when new employees come and go. The spreadsheet 

must accept an employees name, their pay scale, and their hours worked for that week. The pay rate 
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must be automatically looked up from the pay rate table. The spreadsheet must absolutely 

reference the superannuation rate and the tax rate.  

The spread sheet must work out the total wage bill for the week and the average pay for the week. 

Use the data provided in the below image. 

 

Tips:   The Gross pay is the Hours worked multiplied by the hourly rate. 
 The Tax is the Gross Pay multiplied by the Tax Rate. 
 The Super is the Gross Pay multiplied by the Super. 
 The Net Pay is the Gross Pay minus the Tax. 
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Part 4 (Performance criteria 4.3, 4.4, 4.5, 5.1, 5.2, 5.3, 5.4) 

Create a simple 3D pie graph highlighting each employee’s net pay. The chart needs to emphasise 

Hugo Boss’s pay. 

The chart is to be on it’s own work sheet and with it’s tab labelled ‘Summary’. The chart should have 

a title and correct labelling. 

Give the chart a footer of today’s date and make the chart as easy as possible to read. It should look 

similar to the image below. 
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Certificate II Assessment 
 

This assessment will cover all the requirements of the unit’s performance criteria and will be based 

on a ‘real world’ business spreadsheet. 

It will include a list of products, an invoice generator, pay roll sheet and a payroll summary chart. 

The assessment must be submitted as one (1) workbook, which includes four named worksheets. 

These worksheets are to be named: Invoice, Products, Payroll and Summary. 

The assessment must be submitted with a cover sheet and a print out of your pie graph. The excel 

file is to be emailed to your lecturer by the due date with your name, student number and 

ICAU1130A Assessment as the subject. 

Part 1 (performance criteria 1.1,1.4, 1.5, 1.7, 2.1, 2.2, 2.3, 2.4, 2.5, 2.6, 3.1, 3.2, 3.3, 3.4, 3.7) 

Create a spreadsheet that is nicely formatted containing the below data. The content of the 

headings MUST remain the same as the example. You must use different fonts, headings, bold, 

italics, different cell colours and different font colours on the spreadsheet. There must be at least 

two (2) types of borders in your products spreadsheet. This spreadsheet’s tab must be named 

‘Products’. 

Code Description Cost (inc GST) 

usb1gb USB Drive – 1Gb $9.95 

usb2gb USB Drive – 2Gb $14.99 

usb4gb USB Drive – 4Gb $32.99 

usb8gb USB Drive – 8Gb $49.99 

hdd250 Hard Disk Drive – 7200rpm – 250 Gb $99.90 

hdd500 Hard Disk Drive – 7200rpm – 500 Gb $149.99 

hdd750 Hard Disk Drive – 7200rpm – 750 Gb $199.99 

hdd1000 Hard Disk Drive – 7200rpm – 1 Tb $249.99 

hdd25010K Hard Disk Drive – 10000rpm – 250 Gb $249.00 

hdd50010K Hard Disk Drive – 10000rpm – 500 Gb $349.00 

hdd75010K Hard Disk Drive – 10000rpm – 750 Gb $599.00 

hdd100010K Hard Disk Drive – 10000rpm – 1 Tb $1028.99 

pcbas PC – Basic – 2.2Gz CPU, 1Gb RAM $699.00 

pcbus PC – Business – 2.8Gz CPU, 2Gb RAM $999.00 

pcgam PC – Gamer – 3.2Gz Dual core CPU, 4GB RAM $1499.00 
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Part 2 (Performance criteria 1.1, 1.2, 1.3, 1.4, 1.5, 1.6, 1.7, 2.1, 2.2, 2.3, 2.4, 2.5, 2.6, 2.7, 3.1, 3.2, 3.3, 3.4, 3.6, 3.7, 5.1, 

5.2, 5.3) 

Create an invoice template (generator) which will allow a user to enter the customer’s information, 

and also be able to add items to the invoice by just entering the code and the quantity. The invoice 

will automatically generate the product description, the total price and the GST payable for that 

particular item. If there is nothing in the code section, that row needs to be blank awaiting the next 

product to be entered. 

It must look like the image below. It must also be formatted like the below image. Feel free to 

change the business name etc.  

Add a footer to the invoice stating that payment terms are 7 days.  
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Part 3 (Performance criteria 1.1, 1.2, 1.3, 1.4, 1.5, 1.6, 1.7, 2.1, 2.2, 2.3, 2.4, 2.5, 2.6, 2.7, 3.1, 3.2, 3.3, 3.4, 3.5, 3.6, 3.7, 

4.1, 4.2, 4.3) 

Create a worksheet which will be used as a pay roll for this fictional company. This spreadsheet is to 

include an image (any) positioned in the top left of the spreadsheet and resized to not take up any 

more than 5 standard sized rows. 

The spread sheet must be able to be changed when new employees come and go. The spreadsheet 

must accept an employees name, their pay scale, and their hours worked for that week. The pay rate 

must be automatically looked up from the pay rate table. The spreadsheet must absolutely 

reference the superannuation rate. The tax rate must be automatically looked up from the tax rate 

table, also using a vlookup. 

The spread sheet must work out the total wage bill for the week and the average pay for the week. 

Use the data provided in the below image. 
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Part 4 (Performance criteria 4.3, 4.4, 4.5, 5.1, 5.2, 5.3, 5.4) 

 

Create a simple 3D pie graph highlighting each employee’s net pay. The chart needs to emphasise 

John Rogers pay. 

The chart is to be on it’s own work sheet and with it’s tab labelled ‘Summary’. The chart should have 

a title and correct labelling. 

Give the chart a footer of today’s date and make the chart as easy as possible to read. It should look 

similar to the image below. 

 

 

 

 

 


